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A Caution

Before you start the implementation, make sure that you have the latest version of this document. You can

find the latest version at the following location: http://help.sap.com#& | SAP 3D Visual Enterprise Viewer 3

The following table provides an overview of the most important document changes.

Version
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1.00

November 28, 2012

First version.

11

July 18, 2013

The Security Information section was
updated.

20
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The Installation Information section
was updated.

21

June 27,2014

The following sections were updated:

® Supported Operating Systems
® Additional Requirements

® Trace and Log Files

2.2

August 13, 2014

The Installing and Activating the

SAP 3D Visual Enterprise Viewer, Add-
On for Electronic Design Automation
section was updated.

2.3

December 11, 2014

The following sections were updated:

® Supported Operating Systems
® Hardware Configuration

® Additional Requirements

24

May 21, 2015

Minor updates for SPO3.

25

November 16, 2015

The following sections were updated:

® Supported Operating Systems
® Hardware Configuration
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26

March 10, 2016

Updated for SPO5.

30
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1 Getting Started

11 About This Document

This Administrator’'s Guide is the central source of information for the technical implementation of SAP 3D
Visual Enterprise Viewer. It provides cross-scenario implementation information as well as scenario-specific
information.

You can use the Administrator’s Guide to get an overview of SAP 3D Visual Enterprise Viewer and its software
units from a technical perspective. The Administrator’'s Guide is a planning tool that helps you to design your
system landscape and it refers you to the detailed documentation that is required, mainly:

* Installation guides for single software units
* SAP Notes

¢ Configuration documentation

¢ SAP Library documentation

This Administrator’'s Guide is a single source of information for the documentation that is available to support
the installation and operation of SAP 3D Visual Enterprise Viewer.

-> Remember

SAP 3D Visual Enterprise Viewer doesn’t have a separate guide for Installation, Operations, and Security
information. Instead, this information is contained within the one guide.

This guide contains all of the following:

* Installation Information
This chapter gives you an overview of the installation components and the sequence in which they're
installed.

* Security Information
This chapter provides you with the information that you require to operate SAP 3D Visual Enterprise Viewer
securely.

¢ Upgrade Information
This chapter provides you with the latest upgrade information.

i Note

You can find the most current version of this document at http://help.sap.com# | SAP 3D Visual

Enterprise Viewer 3.
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1.2 SAP Notes for the Installation

Read the following SAP Notes before you start the installation. These SAP Notes contain the most recent
information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at the Internet address:

https://support.sap.com/notes .

SAP Note Number

Title

Description

2176101 %%

Removal of NPAPI Support in Chrome

affecting SAP 3D Visual Enterprise
Viewer

Removal of Chrome support as of April
2015.

2776183

Java dependencies for SAP 3D Visual
Enterprise Viewer

Describes version change for Java.

279481 ¢

Release Notes for FPO8

Release information.

i Note

Microsoft has now reached end
of life for support of Windows

7; Jan 2020. See https:/www.mi-
crosoft.com/en-us/windows/win-
dows-7-end-of-life-support-infor-

mation #*

As of FPO9, SAP 3D Visual En-
terprise Viewer is no longer certi-
fied against Windows 7 (not tested
against this environment). We sup-
port customers that maintain Win-
dows 7, however if the issue is oper-
ating system dependent, we can't
guarantee fixes.
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1.3

Help Documentation

Description

Information Available

Internet Address

Title

SAP 3D Visual Enterprise Viewer

http://help.sap.com/#|l SAP 3D Visual
Enterprise Viewer > SAP 3D Visual Enterprise

Viewer [Version number] 4

Application Help for SAP 3D Visual En-
terprise Viewer

SAP 3D Visual Enterprise Author

http://help.sap.com/ P |} SAP 3D Visual
Enterprise Author > SAP 3D Visual Enterprise

Author [Version number] }

Application Help for SAP 3D Visual En-
terprise Author

SAP 3D Visual Enterprise Link

http://help.sap.com/ P | SAP 3D Visual
Enterprise Link > SAP 3D Visual Enterprise

Link [Version number] }

Application Help for SAP 3D Visual En-
terprise Link

SAP Visual Enterprise Access

http://help.sap.com/ P |} SAP Visual

Enterprise Access > SAP Visual Enterprise

Access 7.1 }

Application Help for SAP Visual Enter-
prise Access

SAP 3D Visual Enterprise Genera-

http://help.sap.com/fhrw SAP 3D Visual

Application Help for SAP 3D Visual En-

tor ) ) terprise Generator
Enterprise Generator # SAP 3D Visual
Enterprise Generator [Version number] }
User Guides
Description Internet Address Title

SAP 3D Visual Enterprise Viewer

http://help.sap.com# | SAP 3D Visual
Enterprise Viewer » SAP 3D Visual

Enterprise Viewer [Version number] 4

Administrator’'s Guide for SAP 3D Visual
Enterprise Viewer

SAP 3D Visual Enterprise Viewer
for iPad

http://help.sap.com?& | SAP 3D Visual
Enterprise Mobile }

Administrator’s Guide for SAP 3D Visual
Enterprise Viewer for iPad

SAP 3D Visual Enterprise Viewer
for Android

http://help.sap.com# | SAP 3D Visual
Enterprise Viewer } SAP 3D Visual

Enterprise Viewer [Version number] ]

Administrator’'s Guide for SAP 3D Visual
Enterprise Viewer for Android
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Description Internet Address Title

Security Guide for SAP 3D Visual http://help.sap.comfb'w SAP 3D Visual Security Guide for SAP 3D Visual Enter-

Enterprise Generator prise Generator

Enterprise Generator } SAP 3D Visual

Enterprise Generator [Version number] ]

Application Operations Guide for http://help.sap.com |l SAP 3D Visual Application Operations Guide for SAP 3D
SAP 3D Visual Enterprise Gener-
ator

) ) Visual Enterprise Generator
Enterprise Generator > SAP 3D Visual

Enterprise Generator [Version number] ]

Installation Guide for SAP 3D Vis- http://help.sap.comfhrw SAP 3D Visual Installation Guide for SAP 3D Visual En-

ual Enterprise Generator terprise Generator

Enterprise Generator > SAP 3D Visual

Enterprise Generator [Version number] }

SAP 3D Visual Enterprise struc- http://help.sap.comfb'lb SAP 3D Visual Administrator's Guide for SAP 3D Visual

ture manager Enterprise structure manager

Enterprise structure manager }

General Quick Links

Description Internet Address Title
Released platforms https://www.sap.com/prod-
ucts.htmi

To access the Platform Availabil-
ity Matrix directly, enter http://sup-
port.sap.com/pam#r

System sizing https://www.sap.com/about/bench- Quick Sizer tool
mark/sizing.quick-sizer.html#quick-si-

zerflr

1.4 Information Available in SAP Support Portal

You can find information on the following areas in the SAP Support Portal:

General Quick Links

Description Internet Address Title

SAP Notes https://support.sap.com/notes #r
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Description

Internet Address

Title

SAP Software Distribution Center (soft-
ware download and ordering of soft-
ware)

https://support.sap.com/swdc

SAP Product Availability Matrix

https://support.sap.com/release-up-

grade-maintenance/pam.htm| ¥
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2 SAP 3D Visual Enterprise Viewer 9.0

SAP 3D Visual Enterprise Viewer 9.0 can run as a standalone viewer, or as an ActiveX control embedded in
Microsoft Office, NetWeaver, SAP GUI, or HTML. You can use it to view 2D and 3D output from other SAP 3D
Visual Enterprise tools. It is required to insert and view 3D content embedded in Microsoft Office Documents.
SAP 3D Visual Enterprise Viewer is designed to work with Microsoft PowerPoint, Word, and SAP 3D Visual
Enterprise Author to view 3D content.

Viewer Administration Guide
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2.1 System Landscape

The following graphic shows the system landscape for SAP 3D Visual Enterprise Viewer with the required
software units and the required business functions:

Visual Enterprise Viewer

SAP GUI

SAP Visual Enterprise NetWeaver
Viewer 9.0 3" party applications
(ActiveX)

SAP 3D Visual Enterprise Viewer

Viewer Administration Guide
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2.2 Overall Implementation Sequence

This application is standalone, and does not integrate with a back-end system, so there is no equivalent
installation sequence. SAP 3D Visual Enterprise Viewer is installed directly onto your desktop, with no reliance
on any other software or hardware.

Viewer Administration Guide
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3 Installation Information

SAP 3D Visual Enterprise Viewer 9.0 is installed directly onto your desktop, with no reliance on any other
software or hardware.

- Recommendation

The installer only upgrades from SAP 3D Visual Enterprise Viewer 7.1.x version to SAP 3D Visual Enterprise
Viewer 9.0 version. If you have an earlier release than 7.1, it is recommended that you uninstall the previous
version of SAP 3D Visual Enterprise Viewer first, and then install SAP 3D Visual Enterprise Viewer 9.0.

3.1 Installing the Software

This topic describes the process for installing SAP 3D Visual Enterprise Viewer on your computer.

Procedure

1. Close all applications on the computer.

2. Navigate to, and double-click the VisualEnterpriseViewer_xx.exe file in Windows Explorer, where xx

is the version number.
3. Choose Next when the installer starts. The Front-End Installer screen is displayed.
4. Do one of the following:

* Select the SAP 3D Visual Enterprise Viewer 9.0 checkbox to install all components of SAP 3D Visual
Enterprise Viewer

* Expand the SAP 3D Visual Enterprise Viewer 9.0 checkbox to select the features to be installed
5. Click the Next button to choose an install location. Do one of the following:
¢ Accept the default location in which to install SAP 3D Visual Enterprise Viewer.

¢ Click Browse, navigate to, and select the installation folder you require.
6. Choose Next to start the installation.

i Note

The installer firstly performs a check for previous versions of the software, and if detected, the previous
version of SAP 3D Visual Enterprise Viewer is uninstalled.

7. Choose Close when the installation is complete.

Viewer Administration Guide
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i Note

Upon installation SAP 3D Visual Enterprise Viewer will associate with the types .rh, .rhz, and . vds.
All other SAP 3D Visual Enterprise Viewer readable file formats will be associated with only if no other
application is already associated.

3.2 Post-Installation

These are the post-installation steps that are specific for SAP 3D Visual Enterprise Viewer.

Procedure

Creating .rh or .vds files in SAP 3D Visual Enterprise Author for use with SAP 3D Visual
Enterprise Viewer

Load the required files into SAP 3D Visual Enterprise Author, create any required additional content, and use
the Save As functionality to save as . rh or . vds files.

Creating .rh or .vds files in Visual Enterprise Generator for use with SAP 3D Visual
Enterprise Viewer

1. If you are using SAP 3D Visual Enterprise Generator, this can be used to produce .rh or . vds using batch
processing. The creation of . rh and . vds files is an out-of-the-box workflow that can be configured to
produce .rh and .vds derivatives. This can also be configured as an auto translation on checking into SAP
DMS.

2. Configure and run the SAP 3D Visual Enterprise Generator process to produce . rh and . vds files. For
further information on creating . rh and . vds derivatives, refer to the Configuring Derivatives section of the
application help on the SAP Help Portal (http://help.sap.com/#) for SAP 3D Visual Enterprise Generator.

Viewer Administration Guide
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4 Operation Information

4.1

Trace, Log, and Dump Files

Trace files, log files, and dump files are essential for analyzing problems, as they contain details of errors that
occur during a working session. These errors can be interrogated with the log viewer.

Important Log and Trace files for component SAP 3D Visual Enterprise Viewer

Component

Content

File

Path

SAP 3D Visual Enterprise
Viewer

System processes, memory
state

SAP 3D Visual Enterprise
Viewer.log

%userprofile%
\AppData\Locallow\sap\
SAP 3D Visual
Enterprise Viewer

SAP 3D Visual Enterprise
Viewer

Tracing information, includ-
ing benchmark tracing

SAP 3D Visual Enterprise
Viewer.trc

%userprofile%
\AppData\LocallLow\SAP\
SAP 3D Visual
Enterprise Viewer

SAP 3D Visual Enterprise

Application information while

SAP 3D Visual Enterprise

\AppData\Roaming\SAP\S

Viewer itis running Viewer.dmp AP 3D Visual
Enterprise
Viewexr\Dumps
SAPVE.FileTransfer

The File transfer component is used exclusively by the Dynamic Mockup (DMU) transaction. If you do not run
this transaction then no folder or trace file will be present.

You can change the component settings that are stored in %AppData%\ SAP\SAP

3D Visual Enterprise FileTransfer 1.@\Settings.xml. The trace fileislocated
at %USERPROFILE%\AppData\LocalLow\SAP\SAP 3D Visual Enterprise FileTransfer
1.0\Logs\FileTransfer.trc.

Viewer Administration Guide
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Setting Name

Description

Log File Location

LoggerSeveritylLevel

Specifies what severity levels of log mes-
sages are written into the log file

Valid values by priority from highest to lowest
are:

® Fatal

® Error

®  Warning

® Info (default)
®* Debug

® None

For example, if the LoggerSeveritylLevel
is set to Warning, then only messages

with severity level Fatal, Error and Warning
are written into the log file. If the
LoggerSeveritylevel is None, then mes-
sages are not written into the log file.

%USERPROFILE%
\AppData\LocallLow\SAP\SAP

3D Visual Enterprise FileTransfer
1.0\Logs\FileTransfer.log

TracerSeveritylevel

Specifies what severity levels of trace mes-
sages are written into the trace file

Valid values and their meanings are the same

as for LoggerSeveritylevel.

If TracerSeveritylevelislower than
LoggerSeveritylevel, all messages writ-
ten into the log file are duplicated in the trace
file.

%USERPROFILE%
\AppData\LocallLow\SAP\SAP

3D Visual Enterprise FileTransfer
1.0\Logs\FileTransfer.trc

MaxParallelDownloadTas
kCount

Specifies the maximum number of parallel
download tasks.

Valid values: non-negative integer
Default value: 8

Zero (0) value means use up to the number
of virtual processors in the computer.

MaxDownloadRedirection

Specifies the maximum number of URL redi-

Count rections allowed when downloading one file.
Valid values are: non-negative integer.
Default value: 8
Zero (0) value means that URL redirections
are not allowed.
Viewer Administration Guide
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Benchmark Tracing Information

SAP 3D Viewer includes benchmark tracing information. To enable the trace logs, add the Registry
key manually: HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer\Plugins\

{ASE67F33-6DE8-4C19-93B1-197E6963435B}.

The benchmark trace is enabled by default in the registry with the following attributes:

* Name: import_enable_tracing
* Type: REG_DWORD
* Data:l

i Note

Set value to O to turn the trace off.

The benchmark information is written into a . txc file. The . txc file contains the following benchmark

counters:

Counter Type

Description

Total time spent on loading a vzxml file milliseconds

Time spent on parsing a vzxml file milliseconds
Time spent on enqueuing referenced milliseconds
files

Cumulative counters

Total tasks

The total number of download tasks

Succeeded tasks

The number of succeeded download
tasks

Cancelled tasks

The number of cancelled tasks

Failed tasks

The number of failed tasks

Tasks caused waiting

The number of tasks caused waiting.
See Time spent on waiting for a file to
be downloaded below.

Average waiting duration milliseconds The average time spent on waiting for
one task caused waiting. See Time
spent on waiting for a file to be
downloaded below.

Total task group duration milliseconds The total time spent on downloading all

referenced files

Viewer Administration Guide
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Counter Type Description

Average task total duration milliseconds The average total time spent on down-
loading one referenced file

Average task In queue duration milliseconds The average time spent by one file in
the queue before being processed for
downloading

Average task In progress duration milliseconds The average time spent on downloading
one file

Average task Awaiting response dura- milliseconds The average time spent on awaiting re-

tion sponse from a server when download-
ing one file

Average task Download content dura- milliseconds The average time spent on actual trans-

tion

mission of content of one file over the
network

Average task download speed

kilobytes per second

The average speed of downloading one

file

Average task content size kilobytes The average size of one file.

Total content size kilobytes Total size of all files downloaded from a
server

Total URI redirection count The total number of URI redirections
occurred while downloading all files

Per file counters

Time spent on waiting for a file to be milliseconds Files are downloaded in parallel in back-

downloaded ground. By the time when a file is going
to be processed it might happen that
itis not downloaded yet. This counter
shows how much time was spent on
waiting.

Total duration milliseconds The total time spent on downloading
the file

In queue duration milliseconds The time spent by the file in the queue
before being processed for download-
ing

In progress duration milliseconds The time spent on downloading the file

Awaiting response duration milliseconds The time spent on awaiting response

from a server when downloading the file

18 PUBLIC
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Counter Type Description

Download content duration milliseconds The time spent on actual transmission
of content of the file over the network

Average download speed kilobytes per second The average speed of downloading the
file

Content size kilobytes The size of the file

Redirection count The number of URI redirections occur-

red while downloading the file

4.2 Registry Settings

4.2.1 Registry Settings for Saving Files and Loading
Assemblies

There are two Registry settings that may require a manual change if you wish to work with RH files in Legacy
mode.

Saving Files (Compatibility Mode Flag)

The settings for saving files, by default, are always .vds, regardless of the file type with which you are working.
If you are working with .rh files, and wish to save to .xrh, you must make changes in the registry to set the
compatibility mode flag. The flag defines SAP 3D Visual Enterprise Viewer Save behavior.

The VDS save is enabled by default in the registry. To save to RH instead, change the attributes to match the
following values:
* SAVE_LEGACY_MODE Registry Key
* [HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
* SAVE_LEGACY_MODE "=dword:00000001
* Value of 1 - Saving using Viewer Ul will save RH files
¢ Value of @ — Saving using Viewer Ul will save VDS files

If this flag is not set, SAP 3D Visual Enterprise Viewer works in default (Standard) mode. If set, SAP 3D Visual
Enterprise Viewer works in compatibility (Legacy) mode.

Viewer Administration Guide
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Loading Assemblies

The settings for loading assemblies, by default, always support .vds features. If you are working with .xh files,
and wish to load .xh assemblies, you must make changes in the registry to set the compatibility mode flag. The
flag defines SAP 3D Visual Enterprise Viewer Load Assembly behavior.

* LOAD_ASSEMBLY_LEGACY_MODE Registry Key
* [HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
* LOAD_ASSEMBLY_LEGACY_MODE"=dword: 00000001

* Value of 1 — Assemblies loaded in embedded ABAP scenarios support all features available for RH files
as in SAP 3D Visual Enterprise Viewer 8.0

* Value of @ — Assemblies loaded in embedded ABAP scenarios support newer features only available
with VDS files. Assemblies created from RH files will only support features that are also available with
VDS files.

If this flag is not set, assemblies are loaded using new Namespace in default (Standard) mode. If set,
assemblies are loaded using the old Namespace in compatibility (Legacy) mode.

4.2.2 Registry Setting for TIFF Files

By default, all TIFF files are drawn on 3D Viewport and toolbars associated with 3D are enabled for SAP 3D
Visual Enterprise Viewer 9.0 SP16 and later releases.

2D viewing mode for TIFF files is no longer enabled by default. To enable 2D mode, set up the following registry
key and attributes::

* [HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
e "USE_2D_TIFF_VIEWER_ALWAYS"=dword: 00000001

i Note

Some features available in 3D mode are not available in 2D mode, for example, Collaboration.

4.2.3 Registry Setting for Loading VDS Shattered
Assemblies

There is a Registry setting that may require a manual change if you wish to work with shattered VDS
assemblies.

Viewer Administration Guide
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Loading Shattered Assemblies

The setting defines loading of VDS shattered assemblies. You can locate Components either by file name or
Component ID.

* HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer\Plugins\
{C92C054E-B911-4546-B2BD-09E9667A4531} ]

* EnableFileScan"=dword
* Value of 1 — Search by Component ID
* Value of — Search by File Name.

If this flag is not set, assemblies are searchable by File Name, which is the default.

4.2.4 Registry Settings for Legacy Raster Visual Compare

There's a Registry setting that requires a manual change if you wish to work with the legacy Visual Compare
tool for color raster files.

Visual Compare

The setting defines loading of the legacy functionality for Visual Compare.

* [HKEY_CURRENT_USER\Software\SAP\SAP 3D Visual Enterprise Viewer]
* "COLOR_RASTER_COMPARE"=dword: 00000001
* Value of 1 — Use legacy mode
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5 Security Information

5.1 Sandbox

Some of SAP 3D Visual Enterprise Viewer's supported file formats use third party libraries over which there

is little control in terms of security. This means that vulnerabilities in third party code, encountered when
processing corrupt data from an external, untrusted source, might pose security issues and compromise SAP
products.

Sandboxing provides guarantees about what a piece of code can or cannot do, no matter what the inputs.
Sandboxing leverages the operating system-provided security to allow code execution that cannot make
persistent changes to the computer or access information that is confidential. The architecture and exact
assurances that the sandbox provides are dependent on the operating system.

Security through sandboxing is achieved by granting the sandboxed code the least possible access rights and
privileges, ensuring that it works in accordance with a predefined set of rules. The collection of rules that any
code running in the Sandbox must obey is called a Policy, and no other system resources beyond those defined
in the policy can be accessed or operated on from within the sandbox.

The Sandbox for plug-ins feature is found under either the menu |» Edit » Preferences » Security

Configuration 3, or context menu | Preferences # Settings ¥ Security Configuration 3. Sandboxing leverages
the OS-provided security to allow code execution that cannot make persistent changes to the computer or
access information that is confidential. The architecture and exact assurances that the sandbox provides are
dependent on the operating system.

The Sandbox for plug-ins feature also supports the group policy option. Using this, the network administrator
can set a maximum security level and prevent users from changing it. The sandbox handling is implemented
over registry, and is version dependent. The group policy writes to the registry and SAP 3D Visual Enterprise
Viewer uses it to enable or disable sandbox settings.

The .admfileis located at SAP 3D Visual Enterprise Viewer install
folder\DomainGroupPolicies\SandBox.adm

Prerequisites

You have:

* A Windows Server setup with a domain
* Full administrative rights to that server
* SAP 3D Visual Enterprise Viewer already installed

Viewer Administration Guide
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Procedure

Installing the SAP 3D Visual Enterprise Viewer Group Policy "SandBox.adm"

—

Log on to the domain server with full administrative rights.

2. Copy the file Sandbox . adm from the installation folder of SAP 3D Visual Enterprise Viewer, and paste into a
location in the domain server for installation.

3. From the Windows Start Menu, choose | Administrative Tools » Group Policy Management 3.

4. Inthe Group Policy Management tree, right click Group Policy Objects and choose New. Give the group
policy a name, for example, <SAP Group Policy>. The newly added group policy displays under the
group policy objects.

5. Select the newly created policy object, right-click and choose Edit to display the Group Policy Object Editor
window.

6. From the User Configuration folder, right-click Administrative Templates, select Add/Remove Templates,
and choose Add.

7. Browse for the file Sandbox . adm that you have transferred across to the domain server, and openit.

8. Choose Close to apply the changes. A folder entitled SAP 3D Visual Enterprise displays in the
administrative templates. In that folder, double click the Sandbox item to display the sandbox properties.

9. Close the Group Policy Object Editor window to return to the Group Policy Management window. Right-click
the domain to which you want to apply the group policy, and choose Link an Existing GPO. The group policy
object is displayed in the Select GPO, under Group Policy Objects.

10. Log on and run SAP 3D Visual Enterprise Viewer. Check whether the changes in group policy display in the
SAP 3D Visual Enterprise Viewer settings.

i Note

You must log on again to see the updates. This is based on how group policy update is configured.

5.2 URL Redirect Protection

| Restriction

The Enable URL Redirect Protection option has been deprecated (as of FP12). Please contact support for
further information regarding this option.

SAP 3D Visual Enterprise Viewer can be embedded in a variety of hosting applications. One of the main usages
is Web applications using SAP 3D Visual Enterprise Viewer to open online files. SAP 3D Visual Enterprise
Viewer achieves this by accepting an URL pointing to an online resource, managing the downloading process
and displaying the content to the user. When an application sends rogue URL with a redirection directive to

an unsafe domain to SAP 3D Visual Enterprise Viewer, it might pose security issues and compromise SAP
products.

The URL Redirect Protection feature provides defence to make sure URLs redirected to an unknown domain
will not be loaded. First, redirecting to the same domain as the source URL will always be allowed. Second,
redirecting to a domain that matches an entry in the white list will also be allowed. All other redirections will be
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denied. In case of nested redirection, SAP 3D Visual Enterprise Viewer allows up to 8 levels of redirection in one
URL access. Any more redirection request will be denied.

The URL Redirect Protection main switch and the white list can be set by user. However this setting can be
overridden when there is Group Policy applied by administrator.

When the administrator enables URL Redirect Protection, an entry is required in the white list before the setting
can be applied. The entry does not have to be a valid URL. To stop all redirection, administrator chooses Enable
URL Redirect Protection and enters some text in the white list. That allows the administrator to apply the
setting.

The URL Redirect Protection settings located under either the menu |# Edit » Preferences » Security

Configuration J, or context menu |+ Preferences » Settings # Security Configuration J . The URL Redirect
Protection main switch dictates whether SAP 3D Visual Enterprise Viewer will apply this protection. The white
listis a flat editable list containing URLs that can be redirected when the protection is enabled.

The URL Redirect Protection also supports the Group Policy option. Using this, the network
administrator can set a maximum security level and prevent users from changing it. The

Group Policy script file (. adm) is located at: SAP 3D Visual Enterprise Viewer install
folder\DomainGroupPolicies\Inactive\URLRedirectProtection.adm

Prerequisites

You have:

* A Windows Server setup with a domain
* Full administrative rights to that server
* SAP 3D Visual Enterprise Viewer already installed

Procedure

Installing the SAP 3D Visual Enterprise Viewer Group Policy URLRedirectProtection.adm

1. Log on to the domain server with full administrative rights.

2. Copy the file URLRedirectProtection.adm from the installation folder of SAP 3D Visual Enterprise
Viewer, and paste into a location in the domain server for installation.

3. From the Windows Start Menu, choose | Administrative Tools » Group Policy Management 3.

4. Inthe Group Policy Management tree, right-click Group Policy Objects and choose New. Give the group
policy a name; for example, SAP Group Policy. The newly added group policy displays under the group
policy objects.

5. Select the newly created policy object, right-click and choose Edit to display the Group Policy Object Editor
window.

6. From the User Configuration folder, right-click Administrative Templates, select Add/Remove Templates,
and choose Add.

7. Browse for the file URLRedirectProtection.adm that you have transferred across to the domain server,
and openiit.
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8. Choose Close to apply the changes. A folder SAP 3D Visual Enterprise displays in the administrative
templates. In that folder, double click the URL Redirect item to display the URL Redirect Protection
properties.

9. Close the Group Policy Object Editor window to return to the Group Policy Management window. Right click
the domain to which you want to apply the group policy, and choose Link an Existing GPO. The group policy
object is displayed in the Select GPO, under Group Policy Objects.

10. Log on and run SAP 3D Visual Enterprise Viewer. Check whether the changes in group policy display in the
SAP 3D Visual Enterprise Viewer settings.

i Note

You must log on again to see the updates. This is based on how group policy update is configured.
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6 Technical System Landscape

6.1 Supported Operating Systems

SAP 3D Visual Enterprise Viewer runs on the following supported operating system:
* Microsoft Windows 10 64-bit version

Please see SAP Note 3073267# for additional details regarding the support of virtual and other environments
by SAP 3D Visual Enterprise products.

| Restriction

The operating system supports 64-bit version only.

6.2 Hardware Configuration

The minimum configuration for SAP 3D Visual Enterprise Viewer is:

* Core i3 equivalent, or higher
* 8 GB of RAM (more for large model and texture sizes)
* 500GB/1TB (64 bit) hard drive
* Video card with the following:
* 24-bit color with pixel and 3D vertex shader support

* 3D hardware accelerator video card, capable of displaying 24-bit color and supporting Shader Model
3.0 with at least 512 MB of RAM supporting Shader Model 3.0

- Recommendation

The recommended configuration for SAP 3D Visual Enterprise Viewer is:

*  64-bit multi-core Intel” Core i-7 processor”
* 8 GB of RAM (more for large model and texture sizes)

e 3D hardware accelerator video card, capable of displaying 24-bit color and supporting Shader Model
3.0.with 1 GB of RAM

i Note

To use hardware acceleration for viewing large raster images, a video card with the following is
required:
* Discrete 3D hardware accelerator video card, with at least 4 GB of RAM
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6.3 Extra Requirements

There are a number of extra requirements, depending on the way in which you plan to use SAP 3D Visual
Enterprise Viewer:
¢ Publishing to Office Documents
* Microsoft Office 2016 and newer versions with build number starting with 16.0
¢ Both 32-bit and 64-bit versions are supported

i Note

¢ Only desktop version of PowerPoint and Word are supported.

¢ Publishing to PowerPoint (ppt) format is not supported. It's recommended to use PowerPoint
(pptx) format.

* HTML viewing - Browser Client:
* Microsft Edge with Internet Explorer compatibility mode activated
*  MP4 viewing

* For MP4 media file within steps, there is a video pop-up window which plays the video. For other
formats; for example, AVl and MPG, the video plays inside the viewport.

i Note

The appropriate codec is required to view the media file. You may require a third-party video player
that has required codecs.

¢ Visual Compare
* Graphics Card which supports Direct X 11 and Shader Model 2
* HDR Renderer
* Graphics card which supports OpenGL 2.0 and Shader Model 3.0
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7 Upgrade Information

For upgrading, when you install SAP 3D Visual Enterprise Viewer 9.0, any previous versions of SAP 3D Visual
Enterprise Viewer are uninstalled. For regularly updated release and upgrade information, see the SAP Notes at
https://support.sap.com/notes .

i Note

The installer only upgrades from SAP Visual Enterprise Viewer 7.1.x version to SAP 3D Visual Enterprise
Viewer 9.0 version. If you have an earlier release than 7.1, it is recommended that you uninstall the previous
version of SAP 3D Visual Enterprise Viewer first, and then install SAP 3D Visual Enterprise Viewer 9.0.
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8 SAP 3D Visual Enterprise Viewer
Dashboards 4 Add-On v2.0

8.1 Introduction

SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0 is an add-on for SAP Dashboards 4.1 that contains
a 3D Viewer2 component. The 3D Viewer2 component provides 3D model viewing and 3D analytics capabilities

using SAP 3D Visual Enterprise Viewer.

The 3D Viewer2 component allows 3D models to be displayed in HTML output produced by exporting to HTML

(with Flash). Dashboards allow exporting to various types of output file, but exporting to HTML is the only
option that works when a 3D Viewer2 component is used in a dashboard.

The 3D Viewer2 component must run inside an HTML page in order to allow an ActiveX control to be used in a

Dashboards application implemented in Adobe Flex.

Note that 3D Viewer2 components do not work in the Dashboards preview.

A\ Caution

Two SAP 3D Visual Enterprise Viewer add-ons in the same published Dashboard is not a supported
configuration. The SAP 3D Visual Enterprise Viewer Dashboards 4 Add-on fully supports having both v1
and v2 add-ons loaded in the same design session but a designer is expected to configure a Dashboard
using one add-on.

You can use the 3D Viewer2 component to do the following:

* Visual Indexing
Selecting objects in a 3D scene in order to view or use business data related to the selected objects

* Painting
Modifying the appearance of objects in a 3D scene using a set of rules that are applied to business data
associated with the objects in the scene

* Model Views
Selecting views embedded in 3D models in order to select a particular scene

* Steps
Playing step animations embedded in 3D models

* Queries
Running SAP 3D Visual Enterprise queries against the loaded 3D models

For more information, see http://help.sap.com/# | SAP 3D Visual Enterprise Viewer ¥ Version # » SAP
Library for Analytics 3D Add-On for Dashboards

i Note

This chapter assumes the user has basic knowledge of creating Dashboards and using SAP 3D Visual
Enterprise Viewer.

Viewer Administration Guide
SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0 PUBLIC

29


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2F

8.2 Installing the Add-On

Installing SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0 is done through the file management
option in Dashboards. This installs a further component labeled 3D Viewer, which allows you to add and
configure a 3D viewport.

Prerequisites

As a designer, you have installed the following:

Office 2010

Dashboards 4.1

SAP 3D Visual Enterprise Viewer Dashboards 4 Add-On v2.0
Internet Explorer 9, 10, or 11

SAP 3D Visual Enterprise Viewer 9.0

As a runtime user, you have installed the following:

Internet Explorer 9, 10, or 11
SAP 3D Visual Enterprise Viewer 9.0

Procedure

Open the Dashboard Designer, and choose Blank Model to open a blank dashboard.

From the Dashboard Designer, choose | File » Manage Add-Ons 3. The Add-On Manager window opens.
Choose Install Add-On, browse to new SAP 3D Visual Enterprise Viewer Dashboards 4.0 Add-On and click
Open.

Open Dashboards and choose ||» File  New » New 3 to open a blank dashboard.

5. In Dashboards, choose ||¢ File » Manage Add-Ons 3.

30

Click Install Add-On, browse to the location of the . x1x file for the SAP 3D Viewer Dashboards 4 Add-On
and click Open. The Add-On Manager dialog shows that the SAP 3D Visual Enterprise Dashboards 4
Add-On has been installed.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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/contactsap

© 2023 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.
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